BSP SkinMaker v1.06 Guide

The art of making skins
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Version History (BSP SkinMaker)

1.06 21-08-2005

+ Support for "About" conversion from Old skins

+ Ability to set the BackGround color of Any Shape Skins
* Improved Old skins conversion

* Some other code improvements

- Update color issue for Transparent Bars

- Error if StatTxt not used in Old Skin [FullScreen]

1.05 12-07-2005

+ Support for Old Skins

+ MaxWidth for all Display Texts

+ 2x ZoomFactor for the Skin window

+ ToolTip with Action information for buttons

* Improved the Max Width routines

* Improved some "Error control” routines

* Updated (and corrected) the user guide

- Now it should correctly resize the Skin window's height (also with XPstyle Themes)

1.04 07-06-2005
- Fixed selection Font1/2 in Main section

1.03 06-06-2005

+ Load skins by command line

+ Drag & Drop files to load skins

+ Program languages list sorted by name

* Fixed/Improved Choose Multilanguage Description routine
- Status texts border re-resizeable

- It was possible to select alignment if display wasn't used

- Fixed stupid bug with FullScreen v1 skins

- Added check if Display is not used

1.02 19-05-2005

+ Menu icons

+ Right-click menu for buttons

+ License (free)

+ Open BSZ Skins

+ Create BSZ from the current skin

+ Test Skin (requires BSplayer)

+ Apply BSplayers ZOrder to Buttons

+ Link to the homepage in About box

+ Buttons to move Up/Down skin buttons in list

+ Preview of Full Screen skin position on monitor

+ Subtitles Max Width compatible with all BSplayer 1.0 versions
+ Save Multilanguage favorite LNG file position

+ Now BSP SkinMaker is fully translatable (see Lang folder)

+ First start-up -> "Read guide" message

+ Width &(or) Height values for Bars can't be modified if the bar is an Image
+ Some errors handling

+ XPstyle windows

* Modified the GUI a little bit

* Updated (and corrected) the user guide

* Modified Nokya 8310 Skin (Now Mute feedbacks with Volume)
- Fixed a BIG bug: The Volume Bar was missing in the Full Screen Skin
- Overflow when inserting numbers greater than 9 digits

- Transparent button from FullScreen because not supported

- Error if the Language path is invalid or missing

- Fixed other stupid bugs

1.01 12-10-2004

+ Program Guide

+ Multilanguage buttons text

+ Auto assign Multilanguage Buttons Text

- Removed "Tip of the day" window

- Fixed bug while loading Foreground Color for Display texts
- Fixed other stupid bugs

1.00 04-10-2004
- First Public Release



What’s New

Support for "About™ conversion from Old skins — BSP SkinMaker is now able to convert
the “About” region present in Old skins to a button with action “About”, neither Bsplayer is
able to do this, so | suggest you to convert Old skins with this editor ;-).

Ability to set the BackGround color of Any Shape Skins — Instead of the default
Workspace color, you can choose your favorite BackColor for Any Shape Skins simply by
double-clicking the area behind the Skin (where the skin is transparent).

Known Issues

- The skin is supposed to be modified even if the user only selects a button. This is
because the MODIFIED flag is set when a control text, and not the correspondent
variable, changes. This will NOT be fixed.

Requirements

This program was tested on Windows98/ME/XP and seems to work on each of these platforms.
It uses very little memory from your system. The only additional memory it takes is for loaded
images, so if you plan to modify/create skins with tons of pictures, first check to have enough
free virtual memory to open image files.

Also you need Adobe Acrobat Reader (http://www.adobe.com/) in order to read this guide, the
dll file “MSVBVM60.DLL” (http://www.dll-files.com/dllindex/dll-files.shtmI?msvbvm60) to run
the program (this file should come with the Windows installation. If you don’t have this file
make an Internet search for it. This file size is ~1.32MB).

You need BSplayer media player (http://www.bsplayer.org/) to use and test your skins.
Latest version of BSP SkinMaker (http://forum.bsplayer.org/viewtopic.php?p=17200).

Installation
Simply unzip “BSP SkinMaker 1.06.zip” and the trick is done.


http://www.adobe.com/
http://www.dll-files.com/dllindex/dll-files.shtml?msvbvm60
http://www.bsplayer.org/
http://forum.bsplayer.org/viewtopic.php?p=17200

Introduction

Now that BSP SkinMaker has been installed you have three choices:

1. Create a New Skin
2. Create a New Full Screen Skin
3. Open a previously created Skin

Create a New Skin

Before starting BSP SkinMaker you have to paint all needed pictures for your skin.

Main Image
Every Skin needs a MAIN IMAGE, which is the background of your skin.

Note: BSplayer lets you create skins with any shape borders, this means you can give your skin almost all conceivable
silhouette. In order to use this feature all transparent sectors must have the same color as the first top-left pixel of
your image.

After painting the main image save it as Main.bmp (you can give it the name you want, but if
you assign name with a sort of criteria it will be helpful later).

Buttons Images
Now that you have created the background you have to create the foreground, in other words
you have to paint the Buttons images.

As for the main image, buttons can be normal (rectangular) or any shape, plus they can also
be transparent. This means that if a button is transparent it will appear as an any shape
button, but if you click on the transparent portion of the button, BSplayer will acts as you had
clicked on it.

Every button can assume three different conditions:
1. Normal
2. Mouse Over
3. Mouse Down

As the name says Normal means that the button is in normal state (this is the default state
and the one shown when BSplayer starts).

Mouse Over means that the mouse cursor is over the button.

Mouse Down means that the button has been clicked with the mouse left-button and not yet
released.

You have to paint a picture for each one of these conditions for each button.

Unlike main image files, button files can’t be saved with any name, they must be subject to
the following rule:

NAME [suffix]{.extension} -> i.e.: PlayN.bmp

where NAME is the name assigned to the button; suffix is required and can be N (Normal), D
(Mouse Down), U (Mouse Over); extension is optional.

Tip: There is a special suffix A, which is usually used instead of D for the Mute Button. When BSplayer detects that
suffix and you click on the corresponding button, the image with the A suffix remains displayed until you re-click on it.

Bars Images
One more thing and you’ll be ready to start BSP SkinMaker and that “thing” is BARS.



In BSplayer there are two kind of bars: SeekingBar and VolumeBar.

Seeking Bar represents the time elapsed from the beginning of the movie.
Volume Bar represents the current volume level.

You can choose between three types of bars:
1. Normal
2. Customized Image
3. Customized Button

If you want to use Normal bars then you’ve finished and can go to the Using BSP SkinMaker
section, else you first have to paint a seeking bar and/or a volume bar.

Note: If you choose to use Customized Button bars the rule to follow is the same as the one for the shaped buttons
(first top-left corner pixel color will be the transparent color and name must have the mentioned suffix).

Create a New Full Screen Skin

Full Screen Skins have to be made in the same manner as Normal Skins, this means that you
have to create a main image, all the button images you need and bars.
When you save Full Screen images it is better to save them with the “fs” prefix.

Note: Transparent Buttons are not supported in full screen mode, so keep that in mind.

Open a previously created Skin

If you have just created your skin and plan to modify/finish it (or one created from someone
else) follow the instructions in Open... section under Using BSP SkinMaker section.

Using BSP SkinMaker
Now it’s time to start BSP SkinMaker.

Note: All the following examples are based on the “Base skin” made by TinaZ, which skin comes with the BSplayer
installation.

Once you start BSP SkinMaker you’ll notice three menus:

Eile _
[ Mew Skin Fz
[es] Mew Full Screen Skin Chrl4+F2
& Open. .. F3
Exit

Select your Language
¥ i"hoose one of the Following

v English

Italiano

With this menu you can select the language of BSP SkinMaker. You can create your own
translation, check the Lang folder to know how.



Help
é@¥Guide  Fi

gl License  Ctrl+F1
@ about... F1z

The “Help -> Guide” menu will show you this guide, the “Help -> License” will show the legal
disclaimers, whereas “Help -> About” will show you information regarding BSP SkinMaker and
his author.

Using BSP SkinMaker - File menu

[ Mew Skin Fz

[s] Mews Full Screen Skin Chrl+F2

& Open, .. F3

(3] Close F4

Hsave Fg

& Create B5Z from this skin F11

i) Test Skin Chrl+F11
Exit

As you can easily imagine Exit will close the program, Save will save your skin’s information
and Close will close the skin window.

Note: Close, Save, Create BSZ from this skin and Test skin items will be available once the skin window becomes
visible.

Open...
Let’s begin with the Open menu item; the easiest way to understand this application is to edit
a skin.

Tip: You can open skins simply by dragging them into BSP SkinMaker, or on its Program Icon (skins can also be
opened by command-line).

When you click on the Open menu item you’ll be prompted to select the skin file to be open.
Skin files should be one of the following: *.bsz, Skin.ini, Skinvl.ini, Skinfs.ini or Skinfsvl.ini.

- *.bsz represents all the BSZ skins which are zipped versions of BSplayer skins.

- Skin.ini and Skinv1l.ini are for Normal skins and the suffix “v1” stands for Versionl skins
and it’s created by BSplayer for those skins that were made for pre v1.00 versions of
BSplayer.

- Skinfs.ini and Skinfsvl.ini are for Full Screen skins.

BSP SkinMaker is able to recognize which skin type you have selected (Normal or Full Screen)
by the selected file name.



Open... - Normal Skin
If you select a normal skin something like this will appear:

B5F SkinMeker [by Tirio)
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Let’'s examine all these sections.

Images Tool Window
This window handles Main and Buttons Images.

Main Window:
b air W indon

|E:'\BSplayerF'rn‘\Skins"\Ease'\Main.l:ump|[ Erowse J

Ope window only [Hot fully supported wet)

Skin any shape
Fant 1: | | [ S elect J
Fant 2: | | [ S elect J

This frame keeps information on the skin’s main image. The Browse button lets you select the
main image for the current skin and in the textbox beside it is stored the path of that file.
Font 1 and Font 2 allow you to select two desired font files that you want to provide with the
skin (simply copy the fonts in your skin folder and then select them). Use these options if you
intend to use particular fonts in your skin, which fonts don’t come with Windows installation.
Skin any shape sets the flag for the style you want for your skin. If selected, the skin will have
any shape borders else, if not selected, your skin’s borders will be rectangular.



Hereunder is an example on how the any shape flag works:

Buttons List:
Buttons List

Select the desired extension:

oo 5
'

prev =

Hed Hemove
OpEn —
exit Clear

minimize s

Here is a list of all used buttons and respective files extension.

ATTENTION: the extension is in common for all buttons, so if you change the extension all
opened buttons (=in list) will be removed from the skin. The same will occur for Custom
Button Bars.

If you click on Add button you’ll be prompted to select the desired image file from the path
where you saved/opened the skin file. Don’t mind about the suffix of the file you must select, if
it should be N or D or whatever else it should be, because BSP SkinMaker will get rid of it and
will keep only the button’s name.

Up and Dn (Down) buttons became available only when an item of the button list is selected
and their purpose is to move selected buttons up or down in list. This is useful when you have
buttons overlapped together and want some buttons to stay on top to others. For more
information regarding the usefulness of moving up or down buttons read the Apply ZOrder to
Buttons description at page 20.

The Remove button becomes available only when an item of the button list is selected. If you
click on it the selected button will be removed from the skin.

The Clear button clears the list of buttons and removes them all from the skin.

Note: The extension you choose in the Normal Skin is the same you must use in the Full Screen Skin.



Customize Buttons:
Cuztomize Buttons

Buttan: | play
TVPE | Normal button
Action; | Flay
(%) Multilanguage Text [ $lang. Menu.10 ]

(s Custom Text | |

As the title says in this section you can customize your buttons.

In the Button dropdown list you can select the button you want to customize. If that button
was hidden/covered from another image, the selected button becomes on top thus it becomes
visible.

Type list lets you select the type of the selected item (Normal/Shaped/Transparent).

Action dropdown list is a 108 items list of possible actions in BSplayer:

Exit Full Screen

Volume Up

Volume Down

Dedynamic filter increase amplification
Dedynamic filter increase pre-amplification
Dedynamic filter decrease amplification
Dedynamic filter decrease pre-amplification
Preferences

Capture frame - original image size
Capture frame - "What you see"

Full screen switch

Subtitles on/off

Skins

Audio stream volume cycle

Seek backward

Seek forward

Subtitles time correction + / Vobsub inc delay
Subtitles time correction - / Vobsub dec delay)
Subtitles time correction + (small steps) / Vobsub inc speed
Subtitles time correction - (small steps) / Vobsub dec speed
Play

Pause

Stop

Chapter viewer

Switch wait for vertical-blank

Prev

Prev Chapter

Prev CD

Next

Next Chapter

Next CD

Always On Top

Always On Top Ovr mode

Cycle aspect ratios

Playlist

Mute

JumpToTime

Zoom 50%

Zoom 100%

Zoom 200%

Original aspect ratio



Aspect ratio 16:9

Aspect ratio 4:3

Aspect anamorphic

Movie mode

Video info

Pan In

Pan Out

Zoom in (in full screen)

Zoom out (in full screen)

Move picture left (in full screen)
Move picture right (in full screen)
Move picture up (in full screen)
Move picture down (in full screen)
Free resize left (in full screen)
Free resize right (in full screen)
Free resize up (in full screen)
Free resize down (in full screen)
Reset

Show/Hide main window

EQ

Open audio file

Load subtitles

Open movie

Pan-scan

Custom Pan-scan

Desktop mode

Add bookmark

Edit bookmark

Refresh skin

About

Cycle audio streams

Cycle subtitles

Increase playback rate by 10%
Decrease playback rate by 10%
Increase post processing
Decrease post processing

Exit

Close movie

Jump forward

Jump backward

Select chapter

Cycle video streams

Increase subtitle font size
Decrease subtitle font size
Increase brightness

Decrease brightness

Move subtitles up

Move subtitles down

Show/Hide movie time
Increase Brightness (HW)
Decrease Brightness (HW)
Increase Contrast (HW)
Decrease Contrast (HW)
Increase Hue (HW)

Decrease Hue (HW)

Increase Saturation (HW)
Decrease Saturation (HW)
Show HW Color controls dialog



Resize movie window +

Resize movie window -
Increase playback rate by 1 %
Decrease playback rate by 1 %
Switch repeat modes

Switch time/frames

Fast forward

Fast rewind

Boss button

Note: The Action you specify for the selected button, will appear as ToolTip in BSP SkinMaker for the corresponding
button once you move the mouse cursor over it.

In the Custom Text textbox you can insert the Description for your button. Once in BSplayer
that description will be displayed as a tooltip text on the button where the mouse is over and
in the Movie Title Text.

From BSplayer version 1.00 build 808 it’s possible to assign, to buttons, descriptions that
change when changing language interface in BSplayer. This means that if you select English in
the “Options -> Language” menu of BSplayer the description will be in English, if you select
Italiano it will be in Italian and so on... And this kind of option is supported from BSP
SkinMaker by selecting Multilanguage Text and clicking on the corresponding button.

Note: You can use Multilanguage option only if BSplayer is installed on your system and/or at least one BSplayer
language file is present on your computer.

If you select a skin button and then press the Multilanguage Text button you’ll be prompted to
select your language (this selection is made only to help you choose the desired text and it
doesn’t influence the text displayed in BSplayer, since the Multilanguage string is the same for
all the languages):

C:%BSplayerProtlang

Select yaur language:

Arabic.Ing s
Arahbics. Ing 3
Belamuzzian.ng

Bozanzki lhg

Brazilian_Portuguesze. lng

Brezhoneg.lng

Bulgarian.lng

Catala.lng

D anizh. hg

Deutzch.lng

Eeskylng

Eesti.lni

E zperanto.Ing

Finnizh. Ing

Frangaiz.Ing

Galzgo. hg b

C:ABSplayerProtlang Englizh.ng |

10



Once you select the desired language the following window will appear:

Multilanguage Buttons Text X

Chooze Language File

Languages PathiC:\BS playerProtlang | [ Browse |

Select the desired language:  |Englizh.Ing | [ Charnge LMG File ]

Chooze Dezcription

Select the desired description far the curen butkan:

[ESPlayer.lang] s
verzion=1.00 3
Authar=

Comment=

[Menu]

1="0pen file..."
2="0Open URL..."
92="0pen device.."
3="Load extermal audio file..."'
4="Load subtitles. "
h="Save az.."
B="Recent files"
7="Cloze file"
a3="Plavback"
9=""Previous''

10="Play"
11="Pause"
12="5tap"

13="Mext"
14="Previous chapter'
156=""Mext chapter"

16=""Previous CO"' Bt
Language file Section: Language file String:
|$Iang.h-1 erw. 10 | |F"Ia_l,l |

[ 1]8 ] [ Cancel ]

The BSplayer Language folder path is stored in Languages Path and it is self-detected from
BSP SkinMaker if BSplayer v1.xx is installed on your system.

If you Installed BSplayer in a different folder or your desired language file is not there, then
select your desired path by clicking on the Browse button.

Below language path is the selected language. You can change languages simply by clicking on
the Change LNG File button.

In the Choose Description list there’s a list of all possible strings you can select from. When
you click on an item list the corresponding section will be displayed in the Language file
Section textbox while the visualized string will be displayed in the Language file String textbox.
Then click OK to confirm or Cancel to decline the choice.

Tip: To go to the desired section in the list you can simply press the first letter of the section name on your keyboard.
For example if you want to go to the Actions section you can press ‘A’ char on your keyboard and the list will point to
that section, or ‘M’ char to point to the Menu section and so on. You can also press numbers to cycle through all
numbered items of the list.
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BSP SkinMaker supplies an alternative and automated method to assign Multilanguage
descriptions to your buttons. If you have assigned Actions to your buttons then you can utilize
this feature. Simply go in the Images Tool Window and right-click on the Customize Buttons
section as shown in the following picture:

Cuztomize Buttons

Buko assign Mulkilanguage Descriptions to Buktons

T = ——

Type: [ Mormal buttan v
Achar: ."F'.|;3_'r' v
(%) Multilanguage Text [ $lang. Menu.10 ]

(s Custom Text | |

and click on the popup menu Auto assign Multilanguage Descriptions to Buttons. This
command assigns a description to all the listed buttons accordingly to the action assigned to
each one of them.

Coordinates:
Coordinates

s [pimels] [pimelz]

Coordinates indicate the position in pixels of the current button from the top-left corner of the
main image.

Display & GUI Tool Window
In this section it is possible to select which Text display in the skin and how to customize the
BSplayer menu/playlist.

Max Dimensions:
b ax Dimenzions [pisels]

bl s wiclth:

"1 Subtitles Format 1 (%) Subtitles Format 2

If you choose to visualize a Display Text in the skin you can enter the Max width for that text
expressed in pixels.

Subtitles Format 1 & 2 only set the format in which the Subtitle name Max Dimension is stored
in the Skin.ini file. This is made to remedy a BSplayer compatibility issue rose up from build
814. Format 1 is compatible with skins made for BSplayer before build 814; Format 2 is
compatible with BSplayer build 814 and following. Once you open a skin, this format is read
directly from its Skini.ini file and automatically set.

Note: If you put O pixels as max dimension for a display text, then it will not take into account the max dimension
information, and the text will be auto sized.

Display:
Drizplay

Name  [] Movie Tite v

Font: |-"-"-fiﬂ| | ![ Select ]

BSplayer allows you to show 7 different texts in your skin representing:
- Program Version
- Movie Title
- Movie Information
- Movie Length

12



- Repeat Status

- Subtitles File Name

- Player Status
For each one of them you can select FontName, FontSize, FontStyle, FontColor.
Before selecting the appearance of these texts you need to select the ones you want to be
displayed. First choose the text name and then check the white box besides.
Style choices are performed by clicking the squared black button for the color and the Select
button for the Font. When you click on one of these two buttons a dialog window will appear
and then you can select how to modify the text.

Note: If you open a skin that requires a font not installed in your system and not indicated in Main Font 1/2 section,
an error message will appear advising you of the problem. To obviate this problem you can install the indicated font,
or you can manually edit the Skin.ini file through the “View -> View Skin File* menu item, or you can add the font file
in your skin’s folder and select that file in Font 1/2 field in Main section (the last solution is the better).

Coordinates:
Coordinates

s [pimels] [pimelz]

As for the buttons, coordinates indicate the position in pixels of the current text from the top-
left corner of the main image.

GUI:
E{H]

Mame:  []| Meny Back Color ~ B

-

In the GUI section you can choose the appearance of the menu and Playlist. Before selecting
the desired color you have to select the item you want to modify, every not selected item will
be colored with the default one.

Text:
Test

Below vou can insert information about pour skin.

Author; |TinaZ, tinat@wehbteh, com |
URL: | |

Dezcription:

Base zkin

Here you can insert information about the skin and the author.

TrackBar & VolumeBar Tool Window
This is the final tool window for the Normal Skin. Below I'll describe you the options for the
TrackBar, however VolumeBar options acts exactly as the trackbar’s one.

Bar Style:
Bar Style

T¥PE | Custom Bitmap Horizantal Uze Bar

Image: ||:Z"'.BSIIIH_'.-'E[PTD"'.SMI"IS"\EESE'H|[ Browse

[ 1Eorder
[ ] Transparent B ackGround

Before selecting your bar options you have to choose the Type of skin bar to utilize.

13



There are three types of bars and each one of them can be horizontal or vertical.

Use Bar allows you to decide if you want the specified bar to be used in your skin. It also can
hide/show the corresponding bar to make objects that lay under it visible.

If bar style is image dependant you can select the image by clicking the Browse button.
Border and Transparent BackGround are available only for non-image dependant bars.

Note: Use Bar MUST be selected for the bar settings to be modified.

Colors:
Colors

Border Color; !
Mouze Over Color: !
Foreground Color: !
Background Color; !

Colors can be selected only if you select “Horizontal” or “Vertical” bar.

Note: Don’t worry if Border Color changes are not visible through BSP SkinMaker, they will be visible when BSplayer is
started with the corresponding skin.

Position / Size:
Fozition # Size

Left: Yidth:
| 57| | 250

Top: Height:
EE 5]

Through this panel you can select Position (Left / Top) and Size (Width / Height) of your bar.
Note that size will not be taken into account if the bar is a custom image.

14



Open... - Full Screen Skin
If you select Full Screen Skin from the open menu something like this will appear:

" BSP SkinMaker (by Tizio)
File Wiew Select vour Language Help
Full Screen

b oviie Wwitndow Buttons list
|E:\ESpIayerF'ro\Skins\Base'\fsmain.bm|[ Erowse J

Skin any shape

[ ] Modify Estension

Prosition

| Middle ~| | Battom and Tap v

Here pou can zee [Hald on the 1
where the Full Screen o ®O0 SHIFT key to

skin will appear on select bath
your manitor C®O0C Battarn & Taop)

Dizplay Cuztomize Buttons

|Jze Statuz Test Buttor: | play

b & width: [pinels) Tupe: |Normalbutt-:-n

Auction: | Flay

Alignment: | Cintar w |

Fant; |.~‘-\ria| | ‘[ oot J () Multilanguage Test [ $lamg.Meru10
() Custom Test |

Coordinates Coordinates

e [piwels] ¥ [pixels] s [pivels] Y [pixels]

TrackBar Style WiolurneB ar Style

Type: | Custam Bitrmap Horizontal |+ | Lse Bar Tupe: | - | [JUss Bar

Image: |E:'\BSpla}lerPln\SkinskBase\fl[ Browse J Image: | |[ Browse J

[1Border [1Baorder
[] Transparent BackGround [ Transparent BackGround

Colors Position £ Size Colars Position / Size
Border Color: ‘ Left; idth; Border Color: ' Left; wdidth:
Mouze Owver Color: - | 29| | T"‘52| Mouse Over Color: . | | |

Foreground Colar: . Height: Faoreground Colar: .
B ackground Colar; ‘ 43| | 8| Eackaround Colar: '

As you can see the options are almost the same as for the Normal Skin except for the fact that
there is only one tool window, a Position frame for the main window, only one Display text and
Select the desired extension is changed to Modify Extension.

The only things to explain are the new options Position for the main image and Modify
extension.
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Position:

Pozition

EIM-iu:Iu:II;a v B athar anu:l. f;:up v
Here you can see [Hold on the

Wher ke FulSoeer | &2 © O | epier kew to

zkin will appear on \ . select both
wour rorkar SRONS Bottom & Top]

Position allows you to decide where the skin should be displayed when BSplayer mode is Full
Screen. For the axis of abscissas you can choose between Left, Middle and Right; for the axis
of ordinates you can choose between Bottom, Top and both Bottom & Top positions. This
means that if you select “Middle” and “Bottom and Top”, when you will go in full screen mode,
your Full Screen Skin will be displayed in the bottom-center/top-center of the screen every
time you move the mouse pointer respectively to the bottom or to the top of the screen.
Whenever you select a position for your skin, in the Preview box with 6 option buttons you will
see the exact position where the skin will appear in Full Screen on your monitor. You can also
select the skin position by clicking on one of these option buttons. If you want to visualize your
skin at Bottom and Top, you have to hold on the SHIFT key of your keyboard and
simultaneously click on one of the option buttons.

Unlike Normal Skin tool window, Full Screen Skin tool window allows you to select the
extension of your buttons only if you explicitly want to change it. This because BSplayer reads
extension information only from Skin.ini file, so if you have a Skin.ini file, with extension
information in it, in the same folder as Skinfs.ini, BSP SkinMaker will read it by itself.
Otherwise bmp extension will be set by default. If you plan to modify/assign a different
extension to your full screen buttons, remember to modify it also in the Skin.ini file.

Note: If you manually change the buttons’ extension remember that buttons will be recognized only if the extension is
the same for Normal and Full Screen buttons.

Open... - BSZ Skin
Finally (and thanks to UnZip32.dll library) BSP SkinMaker is able to open BSZ skins. You have
to perform only few tasks in order to extract the skin:

BsZ skin File Extraction [

Create a folder with SkinHame "Mokia 8310 +1.1"

Choose path: |C:\BSplayerPro\Skins'Mokia 8310 v1 [ EBrowse |
%) Hormal Skin

[ Eutract i
Lo

1. Choose path where you want the skin to be extracted by pressing the Browse button.

2. Select the checkbox if you want a folder with the name of the skin to be automatically
created in the folder you select.

3. Choose which type of skin you want to open between Normal Skin and Full Screen Skin
(you can choose the type of skin to open only if the BSZ skin contains the proper files).
This operation will not affect the extraction process since both Normal and Full Screen
skins (if present) will be extracted.

4. Press the Extract button.

Once these four operations have been completed (less than 5 seconds), the skin will be
opened with the type you specified.
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New Skin

When you press the New Skin menu item a message will appear informing you that
WHICHEVER FILENAME YOU’'LL CHOOSE, THE SKIN FILE WILL BE SAVED AS “Skin.ini” this is
because that is the only name (except for Skinvl.ini) that BSplayer accepts for the skin
information file. So pay attention to NOT provide names different from SKIN.INI or if you do
so, you must remember that if a Skin.ini file is already present in the selected folder, then that
file will be overwritten when saving your skin.

The program interface should be familiar to you now that you read the Open... — Normal Skin
section, so let’s start.

When you want to create a totally new skin the first thing to do is to select the Main Image.
Then choose which style to adopt, if Normal or Any Shape.

Note: With BSP SkinMaker you can select only bitmap files for the Main Image.

b zir find o

| | [

Sl.qin e-m_l,l shapeﬁ o

Fant 1: | | [ it ]
Fant 2: | | [ it ]

Now all you have to do in the Images Tool Window is to add new buttons in the Buttons List
and then customize them through the Customize Buttons panel.

Tip: If when you add a new button you cannot view it, probably it is because the button is placed in the top-left corner
of the skin and Skin any shape option is selected. To resolve this inconvenience simply remove the Skin any shape
option and once the button is positioned in the right place re-apply the shape option. Alternatively place the button
using the coordinates panel.

First select the style:

Type: Marmal button w
scione [T

Shaped buttan
Tranzparent [not supparted in full screen)

o

Then select the desired action:

Actior: .F.'ia_l,l -
(%) Multil Pause

Stop

O Cust] Chapter viewer

Switch wait for vertical-blank,
Coordinat| Prey

L Frew Chapter
I: Frew CD Bt

And at last assign a description text to the selected button.
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Now you have to position your button in the right place in the skin. This action can be
performed in two manners: you can input X and Y values in the coordinates frame; or you can
drag your button in the desired position with the mouse:

% *C:\BSplayerPro\Skins\Base\skin. ini

When you move your mouse over a button the image cursor changes into a hand and then you
can drag your picture wherever you want within the skin borders. However to fine move your
buttons 1 suggest you to utilize the coordinates panel.

Tip: If you want to position your buttons with more precision, you can Zoom-in the skin window simply by left/right
clicking the skin image when the magnifier appears (to restore the normal zoom simply re-click on the skin window).
Tip: If you want to speed up the Zooming process, deselect the option “Skin any shape” for the Main image.

Tip: If you want to change the BackColor of the Any Shape skins, you can simply double-click on the transparent
portion of the Main image (the gray area in the picture above), and then select the desired color in the dialog window
that will appear. If you want to restore the Default color, you have to delete the line “BackGround=" from the
“BSP_SkinMaker.ini” file.

Now it’s time to select & place the displayed texts. To accomplish this go to the Display & GUI
Tool Window, choose the desired text and check the box beside the text name.

Name  [7] Movie Title v
Y erzion

Fant; A
kMaowie Info

: b ovie Lenght
Coordinates | Fepeat
5 Subtitles
I: Status

Once the desired text has been selected you can set its Font style and color by using the
corresponding buttons (color and style changes will be displayed in the Skin Window).

As for buttons you can move texts by dragging them with the mouse and with the coordinates
panel.

One more thing, when you select texts, in the Max Dimensions frame maximum texts
dimensions become visible/editable. Then you can choose how much those texts should be
long. If the text length is greater than the one you entered, BSplayer will scroll horizontally the
text to show you the entire string (this doesn’t apply if you insert 0 as Max width value).
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I think you have understood how to manipulate GUI options: select the desired Menu/Playlist
section, check the corresponding box and then select the desired color.

Mame:  [#] Wenu Back Colar v
‘Menu Back Colar
T kenu Back Color lcon
Menu Selected Back Color
Below pou cg Meanu Fant Colar
Menu Selected Font Color
Avathar: il Menu Dizabled Font Color
kMeriu Separatar Calar
LURL: Play List Back Calor i

After you typed in skin/author information the only thing you have to do is to select which bars
utilize in your skin.
- Horizontal / Vertical Bar is a colored bar you can choose colors for
- Custom Bitmap Horizontal / Vertical bar is a personalized image bar which appears
gradually depending from the time elapsed / volume level at runtime
- Button Horizontal / Vertical is an ANY SHAPE button you can move into the range you
specify in the Position / Size panel

Tope: Custo Bitmap Horizortal |
Harizaontal
Image:  |vertical

‘Cuztorn Bitrnap Horizonta
Custarm Bitrmap Yertical
Bard map
E Tm o Buttan Haorizontal
FAMEH Btton Vertical

If you select the first option (Horizontal / Vertical bar) you have to choose if you want the bar
to have a border and if the background should be transparent or not by checking/unchecking
the correspondent checkbox. Thus you have to choose which colors to adopt for the bar in the
Colors frame.

If you select one of the customized image style instead of the simple colored one, then you
cannot select border and background style, neither colors, but you must select an image
through the Browse button next to the Image textbox.

Whichever Style you decided to assign to your bar the next and last step is the positioning of
the bar (exactly as for Buttons and Displayed Texts).

Note: Size will not be taken into consideration if the bar style is Custom Bitmap or Custom Button, instead it
represents the dimension of the selected image. For Button Horizontal you can only choose the width action range of
your button, and for Button Vertical you can only choose the height action range of your button.

New Full Screen Skin
When you press the New Full Screen Skin menu item a message will appear informing you that
WHICHEVER FILENAME YOU’LL CHOOSE, THE SKIN FILE WILL BE SAVED AS “Skinfs.ini”.

Make the same steps as the ones made for the New Skin section in this guide.

Remember to set the Main Image position following your requests and remember also that
there is only one displayed text in full screen mode, and you can select the alignment of it
simply by choosing the wanted alignment option from the dropdown list.

Test Skin

Test Skin will load the skin in BSplayer. To perform this you have to save the skin, and BSP

SkinMaker will ask you to create the BSZ version of your skin.

Note: This feature will work only if .bsz extension is registered to BSplayer, and BSplayer is installed on your system.
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Using BSP SkinMaker - View menu

This menu will appear only once you select a skin file (new or opened) and it lets you
close/open tool windows.

View
v Images ToolBar F&
v Display & GUI ToolBar  F7
v Track & Volume ToolBar  FS

£ Wiew Skin File Fa
E. Apply Z0rder ko Butkans  Crrl+-F3

Full Screen ToolBar will become available only if full screen Skin is opened.

View Skin File command will show you the current Skin file for manual modifications.

Apply ZOrder to Buttons will order Buttons, Texts and Bars like BSplayer does. This means that
if two buttons are overlapped, the one that is much down in the Buttons List, will be shown
atop and the much up in list will be shown behind; buttons are shown over Texts and Bars,
and Bars are shown over Texts.

Note: View Skin File command opens your skin file with the default editor for .ini file (Notepad is default).

Using BSP SkinMaker - Buttons right-click Menu

If you right-click on a button, a popup menu appears with specific actions for it.

4 Mave up in lisk

& Movve down in lisk

¥ Move at bottorm of list

T Remave

> Clear list

E. Apply Z0rder to Butkons

These actions can be performed also from Buttons List frame and View menu except for the
item Move at bottom of list.
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How to Create BSZ Skin Files (the simplest way)

You can simply create BSZ skins (BSplayer Zipped skin or Bsplayer Skin Zipped) by clicking
the menu item Create BSZ from this skin. The skin must be saved prior to create the BSZ skin.
The creation process is pretty simple. Once you click the corresponding menu item the
following window appears:

BSZ skin File Creation [

[] Recurse subfolders

v| abd.brnp s
v abr.brp 3
v| abu.brp Select All
w| bln.brmp
v| b1u.brp
v bZn.brp
v| bZubrmp
v| bdn.bmp Select None
w| b3 brp

v| bdn brnp w

Skir file: ||:Z"-.E5D|-E|}'EfF'fD"x5kiﬂS"anSE.|:ISE |[ Browse ]

[ Create i

In the list, you can select the files to include/exclude in/from your skin, this becomes handy if
you want for example to exclude the rgn.dat file from your BSZ skin, or if you have other files
you don’t want to include.

Select All button will add all the files in the current folder in your skin file.

Select None will remove all the files in the current folder from your skin except for the
“Skin.ini” and “Skinfs.ini” files which are required for the skin.

Recurse subfolders will include, as the name says, all the folders contained in the current one,
with all the files.

Once you have done with these options and selected the BSZ skin file, you only have to press
the Create button.

How to Create / Modify BSZ Skin Files (the manual way)

That is not so hard as it could appear.
BSZ files are nothing but Zip files renamed to have BSZ extension.
So if you want to modify a BSZ skin file, you have to:
Change the extension to ZIP
Unzip the archived files to a folder
Modify the skin manually or with BSP SkinMaker
Create a new <archive_name=>.zip archive with all the skin files the skin necessitates
(NOT the folder, ONLY files)
5. Rename the archive to <archive_name=>.bsz
And the trick is done.

PONPE

If you want to create a new BSZ skin file just follow previous step from 3™ to 5™.
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Conclusion

Below is my second skin made for BSplayer v1.00, you can utilize this for testing the program,
watch films in BSplayer, fill your trash up or what else you want to do.

" BSP SkinMaker. (by Tizio)

File Wew Select your Language Help
Images.
bl air indow
|C:\BSplayerProtSkinsiokia 8310 +1.1| [ Browse

Dne window only (ot fully supported pet]
Skin any shape
Fant 1: |

Select

|
Fant 2: | | Gelect

Buttons List

Select the desired extenzion:

Prese e

Pauze
Stop
Open
RER

E wit
Back

Custamize Buttons

Buttan: | Play

Type: | Shaped buttan

Achion: | Play

) Multilanguage Text [
) Custom Test |

$lang. ductions. 21

Coordinates

kS [pimels] T [pixelsz]

TrackBar

Bar Style

Type: | Horizontal ™ | Use Bar

Image: | |[ Browse ]

[ earder
[ Transparent BackGround

Colors Pozition £ Size
Border Color; . Left: it

. | 2 | a0]
Moz Over Color; .

Faregraund Colar: . Top Height
Background Colar; _J | 139| | 3|

%] Display & GUI

YolumeBar

FEX

tlax Dimenzionz [pixelz)

I

) Subtitles Format 1

I & waidth:

(%) Subtitles Format 2

Diizplay

Mame | Version v |

| .[ Select ]

Font:  [arial

Coordinates
S [pimels] [pixelz]

GUI

M ame: | Menu Back Calor

# _|

Text

Below you can insert infarmation about wour skin,

Author: |Ti2iano Brusa - tizio_bi@hotmal con |

URL: |http:##www.bsplayer.orgf’ |

Dezcrption:
Maokia 8210 - Februany 2005

Bar Style

Type: | Custom Bitmap Werical | Usze Bar

Image:  |CABSplayerProtSkins\Nokia | [ Browse |

[] Barder
[ Transparent BackGround

Colars Pazition / Size

Barder Color: Left: Width:
touse Over Calor: = | 112' | 5|
Foreground Calor: l Top Height

B ackground Color: l | ,‘a‘sl | 54|

In the end | want to thank BST for providing us the great BSplayer media player, my girlfriend
Claudia and my best friend Anthony for believing in me and in my works, and all of you guys, |

hope you’ll enjoy the program.

Tiziano Brusa
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